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Overview

You can work with the contents of the Piano, Sample, Organ Presets 
and the Program partitions. These are accessed from the tabs, conve-
niently labeled, Piano, Samp Lib, Program and Organ Presets. 

If no Nord unit is connected to the computer, pages, icons and memory 
locations will be grayed out. 

Only the appropriate tabs for each individual instrument are available. 
The Wave e.g. is not compatible with the Nord Piano Library which 
means that the Manager will not show a Piano tab if a Wave is con-
nected to the computer.

The actions that take place in the Nord Sound Manager will affect EE
the memories in the Nord unit. The Manager is on-line with a 
connected Nord at all times; any changes that you perform in the 
Manager will immediately be executed in the instrument. If you 
e.g. delete a piano, sample or a Program from the list in the Nord 
Sound Manager, that same sound will also be deleted from the 
Nord Flash memory.

The Toolbar

The Toolbar gives you direct access to some of the more frequently 
used functions in the Nord Sound Manager. Clicking on an icon will 
activate one of these functions, and a dialogue will often appear asking 
for confirmation or further instructions from you.

The Tabs

Select the partition that you wish to work in with the Tabs. The Piano 
tab allows you to change the content of the piano partition, the Samp 
Lib tab is the sample partition and the Program tab allows you to 
organize the programs etc. The individual pianos, samples, programs or 
organ presets will be referred to as “sounds” in this manual and in the 
application itself.

Press Ctrl+Tab on the computer keyboard to cycle between the 



tabs.

The lists can be ordered according to location, name, size, version and 
date, in ascending and descending order. Just click on a headline to 
select a preferred view.

Partition Memory Indicator
The memory indicator at the bottom of the window indicates how much 
memory is being used in the selected partition. The red area shows the 
used memory, green indicates space that is available for new sounds.

Right-Clicking
If you right-click on a sound, a context menu will provide the following 
options:

Select in Instrument

This will select the chosen sound in the Manager list, to be instantly 
accessible on the Nord. 

 

Nord Sound Manager
 

The Nord Sound Manager is the application that allows you to organize the various memory areas, the partitions in your Nord unit. The functionality 
of the Manager depends on which Nord instrument you use. It can also used to download pianos, samples or programs to the Nord or to upload 
any of these items - called sounds - from the Nord memory to the computer hard drive. The Nord Sound Manager provides access to various meth-
ods to download the sounds to the unit and a function to backup and restore the entire Nord memory.

System requirements
The Nord Sound Manager is compatible with computers running Mac OSX 10.4 or later, Windows XP and Windows Vista. If you run the Nord 
Manager on a Windows computer, you also need a Clavia USB Driver of version 2.14 or later installed. The Nord units that are compatible with the 
Sound Manager are: Electro 3, Stage and Stage EX (from OS v4.0), Wave (OS 2.x) and Nord C2.

Nord OS Updates, USB drivers and instructions on how to install these are available at the www.nordkeyboards.com website and on the DVD MM
that accompanies this unit.
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Upload

This will upload the selected sound from the Nord instrument to the 
computer hard drive to a folder of your choice.

Download

This is only available if you right-click on 
an empty location that does not contain a 
sound. This allows you to choose a file on 
the hard drive, to be downloaded to the 
location in the Nord instrument.

Rename

This allows you to rename, and assign a category to a Program. Char-
acters supported are: a-z, A-Z, 0-9 and a hyphen (-) and the name can 
contain up to 16 characters. Any other characters will not be displayed 
in the Sound Manager lists.

Pianos or Samples cannot be renamed, this option will not be MM
available if you right-click on any of these.

Delete

This will delete the selected sound(s) from the Nord instrument 
memory.

File Formats
The Nord Sound Manager creates and/or uses files with the following 
extensions, depending on which unit is used:

.npno - These are the piano files from the Nord Piano library.•	

.nsmp - These are the sample files from the Nord Sample library.•	

.nepg - These are the Electro 3 Program files. •	

.neop - These are the Electro 3 Organ Preset files.•	

.nwp - These are the Wave Program files. •	

.nspg - These are the Stage Program files.•	

.nss - These are the Stage Synth Patches files.•	

.ncpg - These are the C2 Program files.•	

.neb - This is the extension used for the Nord Electro 3 backup files.•	

.nwb - This is the extension used for the Nord Wave backup files.•	

.nsb - This is the extension used for the Nord Stage backup files.•	

.ncb - This is the extension used for the Nord C2 backup files.•	

Just as any other computer file on your hard drive, these files may be 
renamed, emailed, copied, moved, lost or even stored in a safe loca-
tion if an evil computer crash suddenly decides to take your hard drive 
for ride.

The files are exclusively compatible for each individual model, the only 
exception to this are the Piano- and Sample library files that several 
models can use. 

The Quick Tour
Let’s get acquainted with some of the functions in the Nord Sound 
Manager.

Transfer a sound to the instrument
When the Nord  leaves the factory, its memory partitions are filled with 
sounds. In order to be able to download additional sounds, you may 
have to delete some of the factory sounds. If you ever want to reload 
any deleted sounds, they are available on the DVD that was included 
with the Nord, or available as a download from the  
www.nordkeyboards.com web site, in the download area.

Deleting a sound 

Connect the Nord to the computer and launch the Nord Sound 1	
Manager.

A tab will open and the current content of the partition in the 2	
instrument.

Select a piano to delete and press the Delete icon in the toolbar.3	

You can also right-click on the sound and choose the Delete option or 
use the backspace or delete keys on the computer keyboard.

You will be asked to confirm your intentions and then the sound in 4	
the Nord will be deleted.

Download a new sound

Using drag and drop1	 : Open the folder on the computer hard 
drive where the new sound is located.

Make sure that the Sound Manager window and the folder are 2	
visible on the screen.

Drag the new sound to the white area in the Sound Manager 3	
sample list. When the destination location will turn gray, release 
the mouse button.

The Clean Deleted Space process will start to prepare the memo-4	
ry and then the new piano will be downloaded to the instrument. If 
there isn’t enough free space, a message will appear in the lower 
left text area in the Nord Sound Manager.

If the Organize option is active in the View menu, you can drop 



a sound on any free location in the bank. If this function is not 
active, the new sound will be automatically placed at the first free 
location in the bank.

The pianos are categorized and can only be added to the correct MM
bank; electric pianos can not be added to the grand bank, the 
grand’s cannot be dropped in the clavinet bank etc.
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Using the Toolbar or Menu command1	 : Click on the Sound 
Down icon in the toolbar. The same command is also available in 
the File menu: Sound Download (Ctrl-D).

Browse to the folder on the hard drive where the desired sound is 2	
located, select it and click Open. The sound will now be added to 
its bank.

These methods can also be used with any program, sample, 



organ preset or piano that you wish to add, as long as the unit is 
compatible with that type of sound.

Upload sounds from the instrument
Select the desired partition that holds the sounds that you wish to 1	
store on the computer hard drive.

Select the bank and the sound. Shift-click will allow you to select 2	
several consecutive sounds; Ctrl-click will allow you to select 
nonconsecutive sounds. Here we have selected a few of the 
samples:

Click on the Sound Up tool or right-click on the selected sound(s) 3	
and select Upload. The dialogue will prompt you to browse to the 
desired destination folder on the hard drive. The upload process 
may take a few moments depending on the size of the sounds.

Upload a complete partition to the hard drive
Make sure that the desired partition (and bank) is focused in 1	
the Nord Sound Manager. You will also have the opportunity to 
change the source bank in an upcoming dialogue.

Click on the Bank Up tool, or select the File/Bank Upload menu 2	
command (Ctrl-Shift-U). Verify that the source bank is correct and 
browse to the desired destination folder on the computer hard 
drive.

You can also select All at the bottom of the sample bank list drop 
down. This will upload the entire content of the partition to the com-
puter hard drive.

If the Create Subfolders option is checked, a folder structure - partition/
bank/sounds - will automatically be created in the destination folder.

Download sounds to the instrument
Click on the Bank Down tool, or select the File/Bank Download 1	
menu command (Ctrl-Shift-D).

Verify that the destination bank is correct and browse to the de-2	
sired source folder on the computer hard drive.

When you click on Download a dialogue appears to inform you MM
that the content of the destination bank in the Nord instrument will 
be replaced with that of the source file. 

If you select All in the destination bank drop down, you can replace all 
the sounds in a partition with those on a folder structure on the hard 
drive. If Search Subfolders is active, you can browse to the top folder 
of a structure as the parent of the source files.

Organize the program partition
By using drag and drop, you can organize the content of the Program 
partition.

Make sure that Organize is activated in the View menu.1	

Select and drag a program from the destination location to the 2	
desired location. 

If you drop a sound on a free location, the sound will be moved from 
the source location. If you drop on a location that is occupied, the two 
sounds will trade places.

Select a program and press the Ctrl-key on the computer key-3	
board. If you now drag this selection, the Program will be copied 
and pasted at the destination instead of just being moved. 

Search Box
By entering one or several characters in the Search Box, you can 1	
filter out the content that is presented in the lists.

This provides you with a quick way to find duplicate programs, all 
programs made by the mysterious AD (Ake Danielsson) or all programs 
with e.g. the phrase “string” in their names. 

Auto Select
By clicking on the Auto Select icon in the toolbar, you toggle the Auto 
Select function on or off. 

When this is activated and you scroll through the Pianos, Program or 
Sample list using the computer keyboard arrow keys, these will auto-
matically be selected in the Nord instrument.

Double-clicking on a Piano, Program or Sample will also select it 



in the instrument.
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Nord Sound Manager reference

Toolbar

Organize

When this option is active, the lists will show all the available locations 
in the selected partition/bank and not only the occupied ones. This will 
for instance make it easier to drag a file to a specific free location in the 
middle of the list. If this is inactive, only the occupied locations will be 
shown.

Dual View

When this option is checked, the window will be divided in two lists. 
The two lists makes it easy to move programs from one location to 
another. You can make the lists show separate banks with the drop-
downs. Rearranging programs is simply a matter of drag and drop. 
Drag a program from one bank/list to another bank/list in either direc-
tion.

Auto Select

With this function active, scrolling through the program list with the 
computer keyboard arrow keys will automatically select the programs 
in the Nord instrument. 

Sound Up

Use this function to upload one or several sounds from the Nord instru-
ment to the computer hard drive.

Sound Down

Use this function to download one or several sounds from the com-
puter hard drive to the next available location in the selected partition.

Rename

This allows you to rename, and assign a category to a Program. 16 
characters can be used, and the supported characters are: a-z, AZ, 
0-9 and the hyphen (-). Any other characters will not be displayed in 
the Sound Manager lists.

Pianos or samples cannot be renamed so this function is not MM
available if you have selected any of these.

Delete

Allows you to delete one or several selected sounds. You will be asked 
to confirm your intentions. You may also use the delete or backspace 
key on the computer keyboard to perform this action.

Any Program in the Nord Electro 3 or Wave that used that particu-MM
lar sample that you deleted will probably not sound at all, since it 
will be missing an important component.

The space that a deleted sample occupied is not immediately available 
to other sounds, even though it is gone from the list and its location 
is free. The Flash memory needs to be cleaned to free up the space 
where the deleted sounds have been. When you add a new sample 
the cleaning process will be initiated automatically. You also have the 
option to manually start the cleaning process with the Clean Deleted 
Space command from the File menu.

A flashing number in the Nord Electro 3 LED display or Wave MM
OSC2 LED indicates that the sample that the current Program 
tried to use is not available in the Flash memory. Select another 
program or download the missing sample to the unit.

Bank Up

This function will upload an entire bank of pianos, samples or programs 
to the computer hard drive. The default source will be the currently ac-
tive bank, but you may choose another partition and bank if you wish. 
Click on the Choose Folder button to select the destination on the hard 
drive.

If the Create Subfolders option is checked, a folder structure will auto-
matically be created in the destination folder.

If a folder with the same name as the source partition/bank MM
already exists in the location on the hard drive, this folder’s entire 
content will be replaced by the uploaded files from the Nord 
instrument.

Bank Down

This function will download an entire bank of sounds (pianos, samples 
or programs) from the computer hard drive to the Nord instrument. 
The default destination will be the currently active bank, but you may 
choose another partition and bank if you wish. Click on the Choose 
Folder button to select the source on the hard drive.

The destination bank in the Nord instrument will be replaced by EE
the content of the source folder.

Backup

This will make a backup of all the sounds in the Nord instrument. 
The file that is created on the hard drive will have an extension that 
depends on the instrument you have. Backing up the entire memory 
content in this manner will take some time, depending on the sizes of 
the samples.

Backing up from the Nord Sound Manager is done in an incre-



mental manner. Unless you change the name or the location of 
the back up file, only the samples and/or programs that have been 
changed since the previous backup will be saved.

The Nord Sound Manager will suggest a location for the backup, the 
first time this function is activated (in My Documents/Nord Sound 
Manager files/). If you rather save the backup file elsewhere, use the 
browser to pick another destination.

Restore

To restore a previously saved backup file to the instrument, select this 
option and browse to a backup file on the hard drive (file extension 
.neb) and click Open.

The restore function will begin after you have clicked Open and EE
confirmed your intentions in the dialogue. All the content of a con-
nected Nord instrument will then be irrevocably replaced by the 
content of the backup file.
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Menus
In the Nord Sound Manager, the usual Windows and Mac OSX key-
board commands can be used. The menus can be accessed by press-
ing the Alt key and the underlined letter in the menu bar. 

Most of the commands can also be accessed by pressing the Ctrl (on 
the Mac - Command) key together with the letter shown next to the 
command name in the menus.

File 

Sound Upload (Ctrl+U)

Use this function to upload one or 
several sounds from the Nord instru-
ment memory to a folder on the 
computer hard drive.

Sound Download (Ctrl+D)

Use this function to download one or several sounds from the com-
puter hard drive to the next available location in the selected partition.

Bank Upload (Ctrl+Shift+U)

This allows you to upload an entire bank or partition to a folder on the 
computer hard drive. Select the desired source (partition and bank) and 
the destination folder.

If you select All, all the banks in the partition will be uploaded. The hier-
archical folder structure of the chosen partition - partition/bank/sounds 
- will be automatically created in the destination folder.

Bank Download (Ctrl+Shift+D)

Use this function to download an entire bank (or all banks) from the 
hard drive to the Nord instrument.

Please note that you need to match the format of the source and the 
destination, it is e.g. not possible to download a set of programs to any 
of the sample banks.

The content of the source folder will replace the selected bank in MM
the Nord instrument.

Backup (Ctrl+B)

This will make a backup of all the samples, programs and menu set-
tings (System & MIDI menus) in the Nord instrument.

The file that is created on the hard drive will have the extension .nXb, 
where X will depend on which unit you have. 

Backing up the entire memory content in this manner will take some 
time, depending on the sizes of the samples.

Backing up from the Nord Sound Manager is done in an incre-



mental manner. Unless you change the name or the location of the 
back up file, only the samples and/or programs/patches that have 
been changed since the previous backup will be saved.

Restore (Ctrl+R)

To restore a previously saved backup file to the instrument, select this 
option and browse to a backup file on the hard drive (file extension 
.neb) and click Open.

The restore function will begin after you have clicked Open and EE
confirmed your intentions in the dialogue. All the content of a con-
nected Nord will then be irrevocably replaced by the content of 
the backup file.

Clean Deleted Space

This function will clean up the space where any previously deleted 
pianos, samples or programs have been. This is done in order to make 
this deleted memory space available to new additions.

Cleaning is automatically done if you download a new sound to MM
the Nord, but this menu command makes it possible to manually 
start the cleaning process.

Format

This is a radical function; it will format the entire partition that is in 
focus. All the sounds in the partition will be deleted. You will be asked 
to confirm your intentions.

Exit (Ctrl+Q)

Exits the Nord Sound Manager application.

Edit

Rename (Ctrl+N)

This allows you to rename, and assign 
a category to a Program. 16 char-
acters can be used, the supported 
characters are: a-z, A-Z, 0-9 and the 
hyphen (-). Any other characters will not be displayed in the Sound 
Manager lists.

Pianos or samples cannot be renamed so this function is not MM
available if you have selected these.

Delete

Allows you to delete a selected item(s) from the Nord instrument 
memory. You will be asked to confirm your intentions.

Select All (Ctrl+A)

Select all items in a bank/partition.

Invert Selection

This will deselect the original selection and then select all the other 
items in the list.

View

Organize (Ctrl+O)

When this option is checked, the lists 
will show all the available locations in 
the selected partition/bank and not only 
the occupied ones. This will for instance 
make it easier to drag a file to a specific free location in the middle of 
the list. If this is unchecked, only the occupied locations will be shown.

Dual View (Ctrl+L)

When this option is checked, the window will be divided in two lists. 
The two lists makes it easy to move programs from one location to 
another. You can make the lists show separate banks with the drop-
downs. Rearranging programs is simply a matter of drag and drop. 
Drag a program from one bank/list to another bank/list in either direc-
tion. 

Press the Ctrl-key on the computer keyboard to copy a selection 



to the destination during a drag and drop operation.

Auto Select (Ctrl+K)

When this function is active, programs will be automatically selected 
in the Nord isntrument when you browse through the Programs in the 
Manager list, with the computer keyboard arrow keys.
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Help

About

Brings up the About box with a information regard-
ing the version of the Nord Sound Manager. You will also see a list of 
compatible instruments and OS versions, like a Christmas wish list.

Tabs

Piano – Samp Lib - Program – Organ Presets
Use the tabs to select the desired partition. Type Ctrl+Tab on the com-
puter keyboard to cycle between the four tabs. The drop down menu is 
used to select the desired bank within the Piano or Organ Preset parti-
tions. The content of the partition will be presented in the list. 

Search Box
Enter a phrase to quickly present any samples or programs that 
contains the characters. Press Clear to clear the filtering and show all 
entries again.

Loc - Location
The banks are organized in locations; the number of locations varies for 
the different bank types.

Name
The name of the item.

Category
Shows the assigned category for the Programs.

Size
Shows the file size of the pianos and samples. This may be useful if 
you need to know how much space e.g. a particular piano occupies 
in the piano partition. This unit is not shown in the program or organ 
preset lists.

Ver – Version Number
This indicates the version number of the actual piano, sample or 
program format. Older OS versions may not be able to use sounds in a 
more recent format.

Info
This area may contain error information about broken, corrupted or 
rejected files, if e.g. something has happened with a particular sample 
or piano in the instrument.

Footer Area

The footer area is located at the bottom of the Nord Sound Manager 
window.

Partition Memory Indicator
This indicates the usage of the selected partition’s memory. The red 
area shows the used memory and the green area indicates space that 
is available for additional sounds.

The partition sizes varies between the models. Please check the instru-
ment’s user manual. 

Cancel Button
Use this function if you need to cancel a process that is in progress. 
Certain functions like e.g. a restore process cannot be cancelled.

Progress Bars
The two progress bars indicate the progress of an ongoing process. 
The upper bar shows the progression of the individual processes, and 
the lower indicates the status of the entire task.

Message/Text Area
The left part of the text area will present any confirmations or error 
messages from the Nord Sound Manager.

The right part will indicate if a Nord instrument is connected to the 
computer and in communication with the Nord Sound Manager. The 
OS version of the connected instrument will also be displayed here.

Updates and samples
Please visit our website at http://www.nordkeyboards.com to down-
load any updates of the Nord Sound Manager and sounds that have 
been released for the Nord instruments. 
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